Microsoft Outlook 2016 - Level 2

CHAPTER1 ED|T|NG M ESSAG ES

< :lNFOCUS

Most email messages are comprised of text. This is because emalil
messages are used predominantly by people to communicate with
each other. Many of the techniques that are used for working with

text in word processing applications also apply to email messages
in Outlook.

In this session you will:

v" learn how to copy and paste within a message
v' learn how to copy content between email messages

v learn how to copy information from another source
document into a message

v' learn how to delete text from a message

v/ learn how to remove an attachment before forwarding a
message.
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CoPYING TEXT WITHIN A MESSAGE

Most email applications have word processing
features that conform to standard Windows
conventions. In this respect, Microsoft Outlook is
no exception. To help perform basic operations

such as cutting, copying and pasting, Outlook
provides a set of tools on the Compose Tools:
Message tab and the various other contextual tabs
available on the ribbon.

Try This Yourself:

Before starting this exercise you
MUST open the file
Outlook_13.pst...

Open
File

Ensure Mail is selected in the
Navigation bar and that the
Outlook_13 file is expanded in
the Folder pane

Select Inbox in the Folder
pane, then ensure the message
from Fritz Winters with the
Fleet Management Expenses
subject is selected in the
message list

Click on Forward at the top of
the Reading pane to display a
new message

Address the message to either
yourself or one of your
colleagues

Select the table

On the Compose Tools:
Message tab, click on Copy in
the Clipboard group to copy the
table to the clipboard

Click in the top part of the email
where you want to type your
message, then click on the top
half of Paste in the Clipboard
group to paste the table into the
message

Click on Discard at the top of
the Reading pane to discard the
message

©

Search Inbox (Ctrl=E) £ | Current Folder ~
. . - n
© ivanarobinson@outlook.com All Unrezd Meuest
4 Today
4 outlook data file # Fritz Winters
Fleet Management Expenses
Deleted ltems Further to our recent budget
Archive 4 Yesterday
Drafts
Facebook >
Drafts (This computer only) Ivana, you have 3 new notif.. Thu 2:35 PM
_inbux§13 \ lot has happened on
Junk Email 4 Wednesday
Junk E-mail Ivana Robinson U
Outbox Attaching items Wed 10:04 AM
F¥l <end>
RSS Feeds -
n—— Ivana Robinson U
et e Parking Wed 9:54 AM
I Sync Issues 8 Amanda You might find the
[» Sync Issues (This computer only) 4 Tuesday

Search Falders

Facebook

<

=

Send

Fleet

Fleet

From: Fritz Winters [mailto:fritzwinters@outlook.com]
Sent: Friday, 15 April 2016 3:04 PM
To: ivanarobinson@outlook.com

Subject:

Further

Thanks
Fritz

7 Pop Out X Discard

Vehicle 1
Vehicle 2
Fleet Van 1
Fleet Van 2

Truck 1

expenses for the forthcoming year. Can you add the fleet expenses to the
following table?

To... [T wanarohinson @outlook.com;

Subject FW: Fleet Management Expenses

Actual
2013

Actual
2014

Forecast

2016

Forecast

2012 2015

[E (Ctel) =

Fleet Management Expenses

to our recent budget changes, we need to review our fleet management

Actual Actual Actual Forecast Forecast

For Your Reference...

To copy text within a message:

1. Select the text to copy, then click on the
Compose Tools: Message tab

2. Click on Copy in the Clipboard group

3. Paosition the insertion point where you want

Handy to Know...

the text inserted, then click on the top half of

Paste in the Clipboard group

You can use the standard Windows
keyboard shortcuts for copying and pasting
information in an email message. For
example, [ctr] + [€ ] will copy a selection to
the clipboard and [ctr] + [V ] will paste it.
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COPYING TEXT BETWEEN MESSAGES

Occasionally, you may find that you want to required email or the folder that contains it, you can
compose an email message that is very similar to simply open the email, select and copy the desired
a message you have previously created or information and paste it into the new message.

received. As long as you haven't deleted the

s Fleet Management Expenses - Message (HTML)

Try This Yourself: ADOBEPDF @ Tell me what you want to do
~ ~ ~ 7 LR = ECy
(S — . s Mave to: ? a‘ = ¥ Mark Unread pel
R Continue USing the z [ﬁ PEP(S %& Fiéd : £} To Manager M | M B Categorize - T:_f':te B- ZCO}H
E T previous file with this Al 4 [Erememait (5 T B P rolowter | LT k-
(%)) exercise Delete Respond Quick Steps & Mot Edit Message [ [iting Zoom ~
o Fritz Winters <fritzwinters@outlook.com> ivanarobinsang Fri 15/04
o In the message list, double- Fleet Management Expenses G et T esage. v
. 2 View in Browser
click on the message from R Other Actions ' =
Fritz Winters with the ‘ .
Further to our recent budget changes, we need to review our fleet management expenses for the forthcoming
Fleet Man ag ement year. Can you add the fleet expenses to the following table?
Expenses subject to open Thanks

it in a new window
Actual Forecast 2015 Forecast 2016

On the Message tab, click 2014
on Actions in the Move et yor i

group, then select Edit Fleet Van 1

Message Floet Truck 1

Select the table

Click on the Format Text

tab, click on Copy in the Wt == e
Clipboard group, then FormatText  Review  ADOBEPDF Q@ Tell me what you want to do
close the message window =2 CalbriBody) |11+ A A 33} 8% 0 AttachFie P>
9 PPEE B I U iZ-i=.|=s= A&—' ;‘f ) U attach hem - Aﬁ%’! ! ;?
C|IC|( on NeW Em all n the E. ¢ v WA == e Bo:)i‘ Na::a [# signature - AdobeES{end‘ ;c_v";ack 'Y Add‘-{i:s
NeW Items group to Clipboard = Basic Text ] MNames Include Adobe Send & Track (Tags | Add-ins ~

display a new untitled (
message in a new window =

Click in the body of the Bec.
message, then on the Subject
Message tab click on the
top half of Paste in the

Clipboard group to paste Fleet Vehicle 1

the table into the message LG 2

Press [esc], then click on @
[Yes] to close the message
and save it in the Drafts

Actual
2014

Forecast 2015 Forecast 2016

folder

For Your Reference... Handy to Know...
To copy text between messages: e To move text either within a message or to
1. Open a message, click on the Message tab, another message, click on Cut in the
click on Actions in the Move group, then Clipboard group, position the cursor where
select Edit Message you want the text inserted, then click on the
2. Select the text, click on Copy in the top half of Paste.
Clipboard group then close the message o The keyboard shortcut for Cut is [cul] + [X ].

3. Open a new message, click on Paste
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CoOPYING FROM ANOTHER SOURCE

If you have an existing document that contains application that was used to create it and then
information you would like to replicate in a employ the standard Windows techniques to copy
message that you’re composing, you don’t need the desired data or text and paste it into the email
to retype it. You can open the document in the message.

CAR PARKING SPACES

o O O
3500 O O o]

Try This Yourself:

(k]

Continue using the
previous file with this 3000
exercise and open the
file Parking_1.docx... H Canberra

. M Paris
0 Navigate to page 3 of )
the Word document,

then click on the Car
Parking Spaces chart
to select it

e Ensure that the Home
tab is active, then click 1355 gooo 2005 2010
on Copy in the

|
+

Same
File

]

5]

v

=4

Los Angeles

Mantreal

m Berlin

Clipboard group to a
copy the chart to the

clipboard ——
, BT | NE——
e Close Microsoft Word =

Send —
If necessary, click on R B
[Yes] to keep the subject
information on the

clipboard...

3500

3000 —

Return to Outlook and 2 |
create a new message

¥ Canberra

B
8

W Paris

Click in the text area of Los Angeles
the message, then on

the Message tab, click

g

Thousands

Montreal

m Berlin

g 8
|
"
|

on the top half of Paste
in the Clipboard group
to paste the chart into
the message

e Press [esc] and click on
[Yes] to close the
message and save it in
the Drafts folder

For Your Reference... Handy to Know...

To copy data from another source: e You may need to reformat data pasted into
1. Open the application with the data an email message that you have copied from

2. Click on Copy another application.
3. Open the mail message
4.

Position the cursor, then click on the top half
of Paste in the Clipboard group
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DELETING TEXT

Outlook employs most of the functionality that required. The same techniques for deleting text in a
you find for working with text in a word word processing program can be used in an
processing application. You can therefore type, Outlook email message.

copy, move, and also delete text if it's no longer

. To... ivanarobinson@outiook. com;
Try This Yourself: = |
Send —
. . Bre...
o Continue using the
E () o o g q Subject FW: Fleet Management Expenses
g T Previous file with this
n exercise...
@ " the message st B —
I = || k n h m || To: ivanarobinson@outlook.com
ouble-click on the ema

from Fritz Winters with | ——

the Fleet Management

Further to our recent budget changes, we need to review our fleet management expenses far the forthcaming

Expenses SUbjECt year. Can you add the fleet expenses to the following table?
) . Thanks
o Click on Forward in the Fritz
Respond group and
Actual Actual Actual Forecast 2015 Forecast 2016
address the message to 2012 2013 2014
either yourself or one of Fleet Vehicle 1 . -
your colleagues e

Select the text that

appears before the table,
|_ To.. = wanaroblnsm_@.lﬂook‘mm'

as shown s|:;| | (= | N
Press [oe] to delete the 2 W e | [ v
Se|eCted teXt Subject FW: Fleet Management Expenses

Type Here are the

fl g ures Here are the figure
. Actual Forecast 2015 st 2016

Press [esc), then click on | e -

Fleet Vehicle 1
[Yes] to close the . et yor i
message and save it in Fleet Van 1
the Drafts folder e

Fleet Truck 1

For Your Reference... Handy to Know...

To delete text in a message: o If you accidentally delete the wrong text, click
1. Select the desired text on Undo in the Quick Access Toolbar to
> Press reverse the deletion.
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REMOVING AN ATTACHMENT

relevant to the people to whom you are forwarding
the message, you can remove them from the
message before forwarding it.

If you receive a message with one or more
attachments and then forward it to someone else,
the attachments will be included in the forwarded
message by default. If the attachments are not

i To... ivanarobinson @outiook. com;
Try This Yourself: =) -
Send —
o - Continue using the [z
i i i i Subject : Parkin
55 previous file with this sied  [Fwsprking
n exercise... stocnes ] PekingSumeydoos || Parking Dingramjpg

=| 804kB 36 KB Use Adobe Send & Track Yes No @

Open

In the message list,
double click on the

Quick Print

Save As
From: Amanda Bennett [mailto:abennett@alpheiusglobal.c -

message from Amanda Sent: Thursday, 7 April 2016 4:40 PM
B enn ett W|th the Par k| n g To: Ivana Robinson <ivanarobinson@outlook.com> Cut
Subject: Parking -

subject B Cory

Hey lvana, Ef} Select Al

X O

Remove Attachment I,\\,

Click on Forward in the
Respond group, then
address the message to

You might find the attached survey of interest and also the proposed parking plan.

Regards,
Amanda

either yourself or one of
your colleagues

Right-click on the Parking

Diagram.jpg attachment

. To... ivanarobinson@outiook.com;
in the message header &= |
and select Remove send B’
Attachment as shown =
Subject Fw: Parking

The attachment file will =
disappear from the )
Attached box...

Select all of the text in the
message, press , then
type Can you please
review the attached
parking survey?

Parking Survey.docx

=| 804kB Use Adobe Send & Track Yes No @

Can you please review the attached parking survey?

Press [esc], then click on
[Yes] to close the

message and save it in
the Drafts folder

For Your Reference... Handy to Know...
To remove an attachment from a message: .
1. Open the message with the attachment
2. Right-click on the attachment
3. Select Remove

You can remove an attachment from an open
message by highlighting the attachment file’s

name and pressing [pel].

e You can view options for what to do with an
attachment by right-clikcing on the
attachment and selecting an option.
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cerer2  ORGANISING MESSAGES

( )lNFOCUS

Outlook provides a number of tools and features for organising your
email messages. For example, you can delete messages and move
and copy messages to your own custom mail folders. You can also
use quick styles to perform multiple step functions on your
messages with a single click, plus more.

In this session you will:

learn how to create a mail folder

learn how to move messages into other mail folders
learn how to copy messages between folders

learn how to delete messages

learn how to recover messages from the Deleted Items
folder

learn how to clean up conversations

learn how to work with the Favourites folder list
learn how to delete message folders

learn how to recover deleted folders

learn how to empty the Deleted Items folder
gain an understanding of quick steps

learn how to customise default quick steps
learn how to create a new quick step

learn how to use quick steps

AN NENEN

learn how to archive messages
learn how to recover archived messages.

AN N N N N N R T
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CREATING A MESSAGE FOLDER

A message folder is a repository for mail
messages. There are a number of standard
message folders in the mailbox including the
Inbox, Outbox, Sent Items, Deleted Items, and

Microsoft Outlook 2016 - Level 2

S0 on. You can create additional message folders
to store your messages. For example, if you are
involved in several projects, you could create a

folder for each project to store messages.

Try This Yourself:

Before starting this
exercise you MUST
open the file
Outlook_14.pst...

Open
File

In the Folder pane,
ensure the outlook data
file is expanded, then
click on Inbox under
outlook data file

Let’s create two new
folders for the Amazon
and Thames projects...

Click on the Folder tab
to see the commands
you can use with
Outlook folders

Click on New Folder in
the New group to open
the Create New Folder
dialog box

Type Thames in
Name, then ensure
that Inbox is selected
under Outlook Data
File in Select where to
place the folder

Click on [OK] to add
the new folder under
Inbox

Repeat steps 2to 5 to
create a new folder
called Amazon in the
Inbox

©

g File Home Send / Receive Folder View ADOBEPDF Q Tell me what y
Copy Folder (E}"] IT_\ Al 7 Clean Up F
1 2 Move Folder (&) z (% Delete Al
New MNew Search = Rename Mark All Run Rules  Show All
Folder  Folder Folder ' DeleteFolder  5cRead  Now  Folders AtoZ Recaver De
Mew Actions Clean Up
Search Inbox (Ctrl=E) yel Current Folder -
» ivanarobinson@outlook.com All Unread ByDate ~  Newest 4
4 Last Week
4 outlook data file Fritz Winters
Fleet Management Expenses Fri 15/04

Create Mew Folder

Name:

Folder contains:
Mail and Post ltems

Select where to place the folder:

*

v [E Outlook Data File
|5 Deleted ltems
Archive

> E| Calendar

[2=] Contacts
Drafts
Drafts (This computer anly)
Inbox (12}

E| lvana's Calendar

E‘E' Journal

{7 Journal Mhis comouter onlvl

o

I Ivanarobinson@outlook.com

4 putlook data file
Deleted ltems
Archive
Drafts
Drafts (This computer only)

4 Inbox 12

Amazon
Thames
Junk Email
Junk E-mail

Outbox
RSS Feeds
Sent ltems

I» Sync lssues 8

I» Sync Issues (This computer anly)

For Your Reference...

Handy to Know...

To create a new message folder: .

1. Click on the Folder tab, then click on New
Folder in the New group

2. Type the name of the new folder and choose
where to place the folder

3. Click on [OK]

You can also create a new mail folder by
right-clicking on an existing folder in the
Folder pane and selecting New Folder.
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MOVING MESSAGES

Outlook lets you easily move messages between
folders — such as new folders that you have
created or existing ones. There are several ways
to move messages from one folder to another.

Microsoft Outlook 2016 - Level 2

Here we will show you how to use the Move
command on the ribbon as it allows you to move
messages easily into folders anywhere in your
Outlook system.

a Search Inbox (Ctrl=E) L | Current Folder -
Try This Yourself: .
y I ivanarobinson@outlook.com Al Unread Newest ¢
< Today
g ) Comzmue gsmg the . 4 putlook data file " Declan O'Shannassy
g T Previous file with this Thames
0 3 Deleted ltems 9 Hi lvana,
exercise... el .
rchive d Last Weel
o Ensure that orefs b Fritz Winters
R . Drafts (This computer anly) Fleet Management Expenses Fri 15/04
COﬂVGI’SﬁtIOﬂS IS al Further to our recent budget
. nbox
enabled, then click on the mmm— \vana Rabinson 0
Home tab Thames ;’:::a:::;g.’ items Wed 13/04

You can enable
conversations by clicking
on the View tab and

g ADOBE PDF
selecting Show as

Q Tell me what you want to do

Conversa'[ionS in the Move to: 7 ¥ Mover 31 Unread/ Read | Search People D
£3 To Manager - Amazon - Outlook Data Fil
Messa es agroup. .. = g. Amazon - Outlook Data File M
g g p I Team Email - Thames - Outlook Data File Acco{nt'
Undel’ Out|00k data f||e, Quick Steps [E) Amanda's Calendar ubesendiilack ~

A | Current Folde Ivana's Calendar - Qutlock Data File

click on Inbox, then click ]
on the Thames 3

Newest 4 Contacts - Outlock Data File he 81 12:15 PM

conversation

Calendar - Outlook Data File
e
Amanda's Calendar - Outlook Data...

P . nnass
ThIS IS the emall from y Ivana's Calendar - Outlock Data File
Declan O’Shannasy with Junk Email - Outlook Data File
the Subject: Thames... Junk Email - Outlook Dats File

- . -

9 Click on Move in the ht Expenses st | fther:d::
- Opy Lo rolder..
Move group, as shown, to et udoct . .
dspla a Ist Of folders bn l“J ¥ Always Move Messages in This Conversation...
| y |
that you have visited
recently

Your list may be different

to the one shown... » ivanarobinson@outlookcom Al Unread ByDate ~  Newest |
. 4 Today
o Click on/Th am_es - 4 gutlook data file Declan O'Shannassy
outlook data file to move et b Re: Thames 12:15 pM
. elete ems i
the message to this folder o

Archive
Drafts

Click on Thames in the
Folder pane to see the
message in this folder

4 |nbox

Amazan

Thames

Drafts (This computer anly)

Search Thames [Ctrl+<E] P | Current Folder -

For Your Reference...
To move messages:
1. Select the messages to move

2. Click on the Home tab, then click on Move in
the Move group

3. Click on the desired folder

Handy to Know...

e You can drag messages between folders in
the message list and from a folder to a folder
icon in the Folder pane.

e You can drag and drop folders to new
locations in the same way that you can drag
and drop mail messages. Any items within a
moved folder will move with the folder.
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COPYING MESSAGES

If you want to place a copy of a message in more which you can perform this feat. You can use the
than one location, Outlook allows you to copy ribbon, drag and drop, or the keyboard shortcut
messages between folders. And just like many combination - [ctr] + [ Jand [cul] + [V ]

other functions, there is more than one way in

o N Search Inbox (Ctrl+E) pel Current Folder -
Try This Yourself: » ivanarobinson@outlook.com Al Unread T MNewest (=
4 Last Week
g o Contlnue USIng the 3 AT G D Elf:fh::{;:tfr;senta enses Fri 15/04
ST previous file with this Deleted terns 9 Furher to ot recent budget '
) g
exercise... Archive Ivana Robinsan o
Drafts Attaching items Wed 13/04
0 Under Outlook data Drafts (This computer only) Fil <end-
i i 4 Inbox Ivana Robinson 1y
file cllc_k on Inbox, vana wes e
then click on the dinazon Amanda You might find the
Introducing the new JTT(;“I _« o vees a0
phase conversation Sk e . Amanda Bennett; Fri.. =
LnsLamal Introducing the new phase...
e On the Home tab, CI|Ck Outbox Hi Fritz, Ivana |'m free all
i ESlEeeds  Amanda Bennett; Fri..
on Move in the Move Sent ltems Introducing the new phase... 8/04/2016
group, then Se|eCt Hi Fritz, lvana I'm free all
Copy to Folder to oneteue € — Q
= ritz Winters ]
Open the Co py Item 5 I Sync Issues (This computer anly) b £/042016
d' I b Search Folders What about the room
ialog box
q Copy ltems x Microsoft Outlook K
e Ensure that Thames is 9 " e
Copy the selected items to the folder: This action will apply to all items in the
Selected Ul’lder InbOX, v E Outlook Data File o oK | selected conversation.
then C|ICk On [OK] ? Iil I}ele?ed & M DDmn't show this message again
Archive Cancel
.. > Calend
Because this is a B Hew.. cancel
1 Drafts
Conversatlon’ a Drafts (This computer only)
message may v [ mbox
display Amazon
e Thames
E lvana's Calendar
i = ) I
o CIICk On [OK] to Copy F‘-—. J:E:::I (This computer only}
the conversation to the Junk Email o
folder
. . e N Search Thames [Ctrl+E) yel Current Folder -
e Click on Thames in the
Folder pane to see the v ivanarobinson@outlook.com A‘"Toi:read ByDate ™ Newest 4
messages in the .
) 3 i Declan O'Shannass
message list “outlook data file i Re:Thames Y 12:15 PM
Deleted Items @ Hi lvana,
Archive 4 Two Weeks Ago
Drofts Amanda Bennett =1
Drafts (This computer only) RE: Introducing the new p... 8/04/2016
A Hi Fritz, Ivana I'm free all
Amazon Fritz Winters
Thames st e e B4Ee
Junk Email
Junk E-mail
For Your Reference... Handy to Know...
To copy messages: e You can copy messages between folders
1. Select the messages using the drag and drop method. To do this,

select the messages to be copied in the
message list, and then press while you
drag them to a new folder in the Folder
pane.

2. Click on Move in the Move group, then
select Copy to Folder

3. Click on the name of the destination folder,
then click on [OK]
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DELETING MESSAGES

delete a message, or in fact anything in Outlook,
the deleted item is moved into a special Deleted
Items folder rather than being actually deleted.

It is good housekeeping practice to purge your
folders of unwanted messages. You can do this
by deleting them. Deleting messages works a

little like the Recycle Bin in Windows — when you

Try This Yourself:

search Inbox (Ctrl+E) yel

Current Folder -

I ivanarobinson@outlook.com All Unread T Newest 4
3 . 4 Last Week
o . Continue using the _  Erits Winters
% E preVIOUS ﬂle Wlth thls JETTE BRI Fleet Management Expenses Fri 15/04
n exercise... Deleted Items 9 Further to our recent budget
frchive Ivana Robinson 0
o Under outlook data Drafts Attaching items Wed 13,04
file click on Inbox, Drafts (This computer only) e
then click on the 4 Inbox Ivana Robinson I
g Parking Wed 13,/04
AttaChlng_ Items Amazon Amanda You might find the
message in the Thames oo n i
message list Junk Emai \ ) -
e Amanda Bennett; Fri... e
e On the Home tab' Introducing the new phase... 3/04/2016
. . Outbox Hi Fritz, lvana |I'm free all
click on Delete in the
iS5 Eeeds b Amanda Bennett; Fri...
Delete group Sent ltems Introducing the new phase... 8/04/2016

The message will be
deleted from the
Inbox...

In the Folder pane
under Outlook_14,

I ivanarobinson@outlook.com

4 putlook data file

search Inbox (Ctrl+E) yel

All Unread
4 Last Week

I Fritz Winters

Current Folder -

v Newest

3 Fleet Management Expenses Fri 15/04
click on Deleted Deleted Items 9 Further to our recent budget
Archive B
ltems to see the Ivana Robinson 0
deleted message Drafts Parking Wed 13/04
Drafts (This computer only) Amanda You might find the
4 Inbox 4 Two Weeks Ago
Amazon b Amanda Bennett; Fri... =]
Thames In.tro.ducujg the new phase... 8/04/2016
Hi Fritz, lvana |I'm free all
Junk Email i
Junk E-mail I Amanda Bennett; Fri...
unk E-mal Introducing the new phase... 8/04/2016
Outbox Hi Fritz, lvana I'm free all
R3S Feeds b Fritz Winters =]
Sent ltems Sacial Club 8/04/2016

search Deleted Items [Ctrl+E) O

Current Folder -

b ivanarobinson@outlookcom | All_ Unread By Date ~  Newest 4
Ivana Robinson [
Attaching items Wed 13,/04

4 outlook data file
Deleted ltems
Archive
Drafts

FY¥l <end>

For Your Reference... Handy to Know...
To delete a message: o If you delete items from the Deleted Iltems

1. Select the messages you wish to delete in folder, they will be permanently removed
the message list from Outlook.
2. Click on the Home tab, then click on Delete e You can permanently delete a selected
in the Delete group message from any folder by pressing +
[0e1]. A message asking you to confirm your
intention will appear.
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RECOVERING DELETED MESSAGES

When you delete a message from all folders
except Deleted Items, they will be automatically

if you realise that you deleted the wrong message,
you can recover a message from Deleted Items

removed from the folder and added to the
Deleted Items folder. If you change your mind or

and move it back to the original folder.

c Search Deleted Items [Ctrl=E) O Current Folder -
Try This Yourself:
y I ivanarobinson@outlook.com All' Unread By Date ~  Newest 4
Continue using the e oon .
(0] Attaching items Wed 13/04
() 0 9 5 A s ¥
% = previous file with this 4 gutlook data file FYl <end>
9 exercise... Deleted [tems
Archive
o In the Folder pane ensure Drafts
Deleted Items iS Drafts (This computer anly)
selected, then click on the 41nbax
Attaching ltems Amazon
message in the message Thames
list to select it Junk Email
s , Junk E-rnail
Let’s return this message :"tb -
to the Inbox... e
RSS Feeds
e Right-click on the Sent ltems
AttaChing ltems I Sync lssues 8
message and pOint to I Sync Issues (This computer anly)
Move then select Inbox — Search Folders
outlook data file
If Inb(?x - OUt_IOOk data file o =' a Search Inbox (Ctrl=E) AR | Current Folder =
isn't listed, click on Other
Folder, select Inbox under » ivanarobinson@outlook.com Al Unread T Newest d
. . 4 Last Week
outlook data file and click =
1 k- Fritz Winters
on [OK] AETLTA TR LS Fleet Management Expenses Fri 15/04
The message will Deleted Items Further to our recent budget
. Archive B 0
dlsappear from the Drafts L\.trtan:_ thbmson Wed 13'%{1
aching items e S
Deleted Items folder... _ Fil <end>
Drafts (This computer anly)
e In the Folder pane, click 4 Inbox Ivana Robinson o
Parking Wed 13/04
on Inbox to ensure the Amazon Amanda You might find the
message has reappeared Thames e e
again in the message list Junk Email : =
)  Amanda Bennett; Fri... -
Junk E-mail Introducing the new phase... 8/04/2016
Outbox Hi Fritz, lvana 1'm free all
RSS Feeds » Amanda Bennett; Fri...
Sent ltems Introducing the new phase... 8/04/2016
Hi Fritz, lvana ['m free all
I Sync lssues 8
I Sync Issues (This cormputer only) b :r’it;l \gi:ters o '201;
ocial Clu /04,
Search Folders What about the room

For Your Reference...
To recover deleted messages:

Handy to Know...

e You can delete or recover multiple messages

1. Click on Deleted Items in the Folder pane Simultaneou5|y. To do this, click on the first
2. Select the required messages in the MEETER2, (1E [IEES el @il e e

desired messages. Press [pe] to delete them
or right-click on them and select Move >
folder name to recover deleted messages.

message list

3. Right-click on a selected message and
select Move > folder name
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